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How To Use This Manual

Thismanual is designed to provide training instructions and exercises to
the beginning user in Corel WordPerfect 7.0 for Windows. There are
many terms and conventions which are unique to the Windows
environment. These are defined in this section of the manual.

Windows Terminology

Mouse Buttons

The following terms will be used extensively throughout the training
manual. They should be familiar to current Windows users.

The mouse is a pointing and selection device which isused in lieu of the
keyboard for many Windows operations. The left mouse button is used to
"select” or "execute" application icons or menu items. There are four
basic mouse functions which use the left button:

Click To quickly press and release the left button

Double-click To click the left button twice in rapid succession

Click and Drag To press and hold the | eft button while moving the
mouse with the hand.

Point To move the mouse pointer to a new location (no
button is depressed)
Right-click To quickly press and release the right button

Select means to highlight text, usually with the mouse. Holding the shift
key and pressing directional keyswill also accomplish the same task.

Point means to move the mouse to an icon or menu option. The cursor is
represented as athick arrow = when pointing. Thisthick arrow will
appear in left margins of documents and in the title bar and menu areas of
the window itself.

Scroll meansto click on the horizontal or vertical scroll bars along the
side and bottom of the window to move the cursor around the document.
The directional arrow keys can also be used to accomplish the same task.

Theterm Vertical bar represents the cursor location within atext portion
of adocument.

Theterm | beam represents the mouse pointer located in atext portion of
adocument. Once the pointer is moved away from the scroll or menu
areas of the window, it becomes an | beam to represent text location.
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Keyboard Keys

Buttons

Menus

User Input

Resulting
Actions

The Status bar isthe locator information constantly displayed at the
bottom of the window. The status bar will reflect the current font on the
left, special features in the center, page numbers, cursor location vertically
(line) and horizontally (position) on the right.

Conventions The following conventions are used throughout this manual
to make it easier for the user to follow instructions and exercises.

All keyboard keys are typed in boldface with Upper and lower case letters
and enclosed in greater than and less than symbols. The enter key is
displayed as <Enter>.

All power bar, toolbar and dialog box buttons are displayed in boldface,
brackets and in the same case as the buttons they represent. The OK
button in adialog box is displayed as [OK].

All menu options are displayed in boldface with an underlined | etter
exactly as the menu options are displayed. The File menu option is
displayed asFile.

Where the user should input keystrokes, the text is printed in boldface.
When a user isinstructed to type the file name basics, it is displayed as
Basics.

When keystrokes result in a change on the screen, status bar or dialog box,
thisisnoted initalics. When a user presses the <Insert> key, this
notation appearsin the manual: The word Typeover appears in the lower
left corner of the status bar.
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Section 1
Corel WordPerfect 7 Basics

Corel WordPerfect 7 is a software application designed to perform word
processing and desktop publishing tasks. This courseware teaches the
skills needed to perform basic word processing using Corel WordPerfect

7.

Start WordPerfect

When default options are used during the Corel Officeinstallation, a
Corél Office 7 group is added to the Start menu. Corel WordPerfect 7 can

be launched from this group.

1. Onthe Taskbar, click the [Start] button.

2. Sdect Cord Office?.

3. From the sub-menu, click Corel WordPerfect 7.

l Corel Office 7

M ew Office Document

Open Office Document

Programs
Documents
Settings

Find

Help

dows2H

Bun...

Accessones r
w Corel InfoCentral ¥

Et? Caorel Prezentations 7
@ Corel Quattra Pro 7

At Corel WordPerfect 7

@ Erway ¥

g B oA L

Wi

Shut Do,
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Corel WordPerfect 7
Screen Elements

Close
Restore
Title Bar Minimize _l
App|ication [olo] sl *  Corel WordPerfect - Document] [unmodified) =
Menu Bar— @Eile Edit “iew |nzert Farmat Table Graphics Tool: Window Help _|E’|5|
The Toolbar— | Dl(E[&] Al=l@sle] blu] 7l H=l @ @=e] =
The Power Bar —» | QuickFonts = |Times New Roman |12 pt =|Styles - | Left - [1.0 -|Tables - | 100% |
Guidelines— T
Workspace —»
Horizontal Scroll Bar _, |, | .
Status Bar— [inzer |HP Laserlet 5L (PCL] |ZelectPg 1 Ln 1" Pos 1"
Next Page —
Previous Page
Vertical Scroll Bar
Title Bar

Thefirst line at the top of the WordPerfect 7.0 window isthe Title Bar. It
notifies the user that WordPerfect is open and displays a document name
(if saved) or document number if not yet saved.

Control Menu Box

The top left-hand corner of thetitle bar isthe Applicationicon. The
Application icon menu allows you to manually maximize, minimize, move
or sizeawindow. It also provides options to close WordPerfect.

CPI Training Solutions, Inc.




Corel WordPerfect 7 Basics Page 3

Menu Bar

The Toolbar

The Power Bar

i“ Guidelines

Workspace

Beneath the WordPerfect title bar is the menu bar. When you click on a
menu option, the pull-down menu will open.

Thetoolbar is located directly beneath the menu bar at the top of the
document screen. The tools represent shortcuts for frequently accessed
menu options.

The power bar islocated directly below the toolbar at the top of the
window document. The power bar provides a quick method of changing
fonts, styles, paragraph formats, and line spacing. It also provides an easy
way to create tables and columns and change the view of the document.

Guidelines show the margins of the document and other elements like
tables. They are non-printing characters.

Y ou can change margins or table column-widths by dragging the
guidelines to the desired position.

The portion of the screen where text is located is called the text area or
workspace. Thisiswhere typing and editing occur. The cursor is marked
by ablinking vertical bar.

CPI Training Solutions, Inc.
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Status Bar

Scroll Bars

Views

The bottom of the screen is the status bar which keeps track of the
insertion point (cursor) at al times. The Pg (page), Ln (line) and Pos
(position) measurements always reflect the current location of the cursor
in the document. It will also reflect the current font on the bottom left and
whether any special character keys or functions are turned on in the center
of the panel.

W | B

[nzert |HP Laser/et BL [PCL) |5elEct Pa1Ln 1" Pos 1"

Typing Current Select Cursor
mode printer mode location

Scroll bars are used to scroll through the document either horizontally or
vertically.

The workspace can be set to different "views' for your convenience.

View Description

Draft No graphics, font changes, headers, footers,
page numbers, or footnotes are displayed.

Page Graphics, fonts, headers, footers, and page
numbers are all displayed in true WYSIWYG
display.

Two Page | Two pages are displayed side by side.

CPI Training Solutions, Inc.
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Change the View

1. Select View from the menu bar.
2. Choose Two Page.
Two pages are displayed, side by side.

& Corel WordPerfect - Document1 [unmodified]
@Eile Edit “iew Inset Format Table Graphicz Tool: ‘Wwindow Help

nl|d|&| 4=l@lole] bl|ul /L& Hi=l2 @@ ald]

QuickFonts * | Times New Foman * |12 pt * | Styles 1.0 w|Tables

|HP Lazerlet 5L [PCL) |ZeectPal Ln1" Pos 1"

3. Select View from the menu bar.
4. Choose Page to return to Page view.

Accessing Menus
Menus can be accessed by clicking the menu name, such as File, in the
menu bar or by holding the <Alt> key and pressing the underlined letter of
the menu name. When amenu is selected, it displays alist of available
commands.

To get out of a menu without making a selection, move the mouse pointer
outside the menu and click once with the left mouse button.

CPI Training Solutions, Inc.
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1. Select Eile from the menu bar.

&% Corel WordPerfect - Document [unmodified] HmEE
(W Edit “iew |nzert Fomnat Table Graphics Tool: ‘wWindow Help _|5’|i|

|~ Mew. Ctl+Shiftehd - 5 T
L sty 8ole] blzlu] A& G=[2] @la)] sla] 4
[0 Ciee CusFg |oman v [12ptv|Siyles | Lett v[1.0 w[Tables ~[100% |
Save Chl+S
Save Az F3
Internet Publisher...
Document 3
"""" Print... Chl+P
Publish ta 3
Send...

1 Software.wpd
2 programs. wpd
3 Software. wpd

Exit Alt+F4

Insert |HF Lazerlet 5L [PCL) [SefEctPal Ln 1 Pas 1"

2. Move pointer outside of menu and click.
Menu is closed.

3. Hold <Alt>and press F.
The File menu is displayed.

4. Press<Esc> twice.

Dialog Boxes
Some of the commands in a pull-down menu are followed by ellipses
(periods). Selecting one of these commands will open a dialog box.
Dialog boxes provide options for certain features.

CPI Training Solutions, Inc.
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Elements of a Dialog Box

There are severa elements that can be found in dialog boxes. Thetable
below gives abrief description of each.

Element
Tab

' Description
Located at the top of the dialog box. Displays
additional options.

List Arrow

Click to get a list of options.

Text Box

Box in which text can be entered. Pointer
changes shape to an I-beam when placed in a
text box.

Check Box

Will display a v when activated. Check box is
activated by clicking, deactivated by clicking.

Command Buttons

Buttons that display a word(s) such as OK. Will
execute a command.

Option Buttons

Buttons that display a dot when activated. Option
buttons are activated by clicking, deactivated by
clicking.

The Eile Print dialog box is shown in the following illustration with each
of the above elements indicated.

=

Select File from
2. ChoosePrint...

the menu bar.

The Print dialog box is displayed, as shown in the following

illustration.
3. Click [Closg] to

close the dialog box.

CPI Training Solutions, Inc.
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Print to HP LaserJet 5L [PCL) HE

Tabs = Print |F'rinter| Two-Sided F'rintingl
— Current printer
HF Lagerlet 5L [PCL) [LPT1:)
— Frint — Copies
Mumber of copies: 1 :
List arrow 4 )
EEI EEI & Gl Option
Text box FEETEE _"Dﬁ-,;l‘l ﬂ ;D;| i’ buttons
[
Resolution: IHigh j @ Group
N e e [ Frint in rexerse order
Check box [— [ Print graphics

N [relude decument summan

Frint I LClose Settings = Status Help

I
Command

buttons

Create a New Document

Upon starting WordPerfect, a new document window is opened and ready
for you to begin. WordPerfect uses word wrap, which means that when
the cursor reaches the right margin, it will wrap down to the next line
automatically. The <Enter> key is used to end one paragraph and begin a
new one.

In the first exercise, we will create a new document, as shown below.
Y our document may not wrap at the same position as the text shown
below.

e Typethe following paragraphs.

WORD PROCESSING BASICS<Enter><Enter>

Word processing beginner s need to know what functionsare
commonly available and how to usethem. That iswhat this section
covers. It contains examples of common word processing features and
concepts. It also explainsthe steps necessary to use a word processor
to create a new document: starting WordPerfect, entering and editing
text, formatting and printing the document, saving text on disk, and
ending the session. <Enter><Enter>

CPI Training Solutions, Inc.
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Edit Text

This course also explains how a word processor managesthe
computer'smemory, discussing where the characters generated by
your keystrokes are moved and stored in every stage of word
processing.

In WordPerfect, Insert mode isa default. This meansInsertis
automatically turned on when you start WordPerfect. That iswhy the
word Insert appears in the left corner of the status bar. If awordis
omitted from a sentence, move the cursor to the position where the word
should appear and type the word.

Deleting charactersin WordPerfect can be done using the <Delete> key
and <Backspace> key. The <Delete> key deletes the character to the
right of the cursor. The <Backspace> key deletes the character to the | eft
of the cursor.

Y ou may wish to type over some existing text in the document. One
technique for accomplishing thistask is Selected Typeover.

Selected Typeover

Deleting Text

Typeover is automatic when text has been selected with the mouse. Once
aword or group of words has been selected, anything which is typed will
replace the selected letters or words.

In the next exercise, we will use Selected Typeover to replace the word
beginner s with the word users.

1. Double-click the word beginnersin the first paragraph to select it.
2. Typetheword users.

There are severa methods that can be used to delete text in WordPerfect.
One of the most effective methods is to select the text, then press
<Delete>.

1. Select theword functionsin the first sentence of the first paragraph.
2. Press<Delete>.

The word functions is deleted.
3. Typetheword functionsinitsoriginal position.

CPI Training Solutions, Inc.
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Using Undo

Undo is afeature that will undo up to 300 tasks that you have performed.
It isvery useful at those times when text is mistakenly deleted.

In the next exercise, we will delete aword and restore it with the Undo
feature.

1. Double-click the word usersin the first sentence of the first paragraph.
2. Press<Delete>.

The word users is deleted from the sentence.
3. Click the Undo tool.

The word users is restored.

Understanding File

Management
When saving afile, Corel WordPerfect 7 defaultsto afolder called
MyFiles.

Y ou may want to further organize your files by creating folders within the
MyFilesfolder. We can now create foldersin the Save File dialog box.

Creating a Folder
A folder is a sub-directory in which you can place files. In the following
exercise, we will create afolder into which we will save our file.

1. Click the Savetooal.

Save As dialog box is displayed, as shown in the following
illustration.

In the Save File dialog box, select File from the menu bar.
3. Choose New.

N
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@
Edit “iew Toolz Fawortez Help
Save Wl ool | | B =l
Folder
Shortout
Create Shortcut S
Delete Del j | A type: IWUldPerfect 6.0/6.1 ["*.wpd""".wpt"""j
Rename F2 : : =
Propeties skdpFiles [ *wpd )
Print File List...
Cloze
Marne: I".WDd j
[~ Passwaord protect Save | Cloze |
|1 object(z] |0 bytes [Disk free space: 579.75ME] | | v

4. Choose Folder.
A new folder is displayed with the name New Folder.

by Computers [C:)5MyFiles [ *wpd |

Jew Folde

5. Type Student for the folder name.
6. Press<Enter>.
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Menu bar —

Save-in folder —

Filename —

4% Corel Office -- Save As - MyFiles
File Edit “iew Toolz Favortes Help

%le(@| x|e| ool

Browse | QuickFinderl

5 ave i |[:| by Files

j B tppe: IWnrdPerfectE.Da’E.'I ["".wpd""“.wpt"""j

[y Computer’ [C:]\MyFiles [ =wpd |

7. Click [Closg] to close the Save File dialog box.

Save a File

Once afileistyped, you should saveit. To save adocument in

WordPerfect, you must type in afile name. The filename can consist of 1

[~ ttame [wpd [
[ Password protect Save I Close |
|'| object(s) selected |D bytes | |File Folder 2

to 255 characters and can contain spaces. Y ou cannot use certain symbols
suchas* . ?/\# @.

1. Click the Savetool.
The Save File dialog box is displayed, as shown in the following

llustration.

CPI Training Solutions, Inc.
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~wnN

A Save File - MyFiles

Fle Edt Yiew Tools Favortes Help

| 3 [l

Browse I HuickFinder |

Save in: |l:| MyFiles j | Astype  [wordPerfect B.0/6.1 [™wpd " wpt™ 7]
iy Computeribain Folder [C:)\MyFiles [ =wpd )
|_1Backup
|1 Student
Mame: I".wpd j
[ Password protect Save | Clase |
|2 object(s]

|0 bytes (Disk free space: 57.71MB] | [

Double-click the Student folder.

Click in the Name: section and enter BASICS.

Click the [Save] button (or pressthe <Enter> key).
The file name appears on the title bar of the document.

CPI Training Solutions, Inc.
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Quick Cursor

Movements
Below is atable of the functions performed by directional keysin Corel
WordPerfect 7:
KEY \ RESULTING ACTION
Up Arrow Moves up one line
Down Arrow Moves down one line
End Moves to end of line
Home Moves to beginning of line on left margin
Left Arrow Moves one character to left
Right Arrow Moves one character to right

Ctrl + Up Arrow

Moves up one paragraph

Ctrl + Down Arrow

Moves down one paragraph

Ctrl + Right Moves one word to the right

Ctrl + Left Moves one word to the left

Ctrl + Home Moves to top of document

Ctrl + End Moves to bottom of document
Page Up Moves to the top of a screen
Page Down Moves to the bottom of a screen

Selecting Text

To affect specific portions of the text, it isimportant to select the text first

using the mouse or shi
To Select:

Entire Word

Entire Sentence

Entire Paragraph

Any other portion

ft and arrow keys.

Position the pointer on any letter in the word and double-
click.

Position the pointer in the sentence and triple-click.

Position the pointer to the left of the paragraph and click
twice.

Click at the beginning of the text to be selected. Move the
pointer to the end of the text to be selected. Press and hold
the <Shift> key and click the left mouse button.

CPI Training Solutions, Inc.
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Edit Select Command

It isalso possible to select text using the Edit Select command. Click on
Edit Select to view the menu options for portions of text which can be
selected automatically.

Close a File

Undo Chrl+Z
Hedo i kRS i
IIndo/Fedo Histom...

i [Etr{F=
[EmmEy [EEr{+E
Paste Chrl+
Paste Special...

Apped

ndelete...  Chl+Shift+2
Fepeat...

Conyert Caze

Sentence
Paragraph
Page

Al Chrl+,

[tz

| jf=e e

Eind and Feplace... Chl+F
GoTo.. Chrl+G
Preferences. ..

rabtlan Ealurmm
Eectanale
rakile

The File Close command closes the current window and clears the file
contents from memory. If edits have been made to the document, adialog
box will appear reminding the operator to save the changes. If no edits
have been made since the last save, the file will be closed.

Close a File Using the Menu Bar
1. Select File from the menu bar.

2. Choose Close.

The text no longer appears on the screen.
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Close a File Using the Control Menu Box
A file can also be closed by using the Document Icon menu box. This

B

menu is located on the Menu Bar directly to the left of the File menu
option as shown in the following illustration.

Document Icon

@Eile Edit “iew Insert Format Table Graphics Tool: Window Help _|5’|5|

nll|g| tl=@ole] bllul ¥ H=R eld @Ea]
QuickFonts | Times Mew Foman *|12pt »|Styles - | Left +[1.0 | Tables - |100% |

WORD PROCESEIMG BASICE

Word processing users need to know what functions are commonly available and how to use
hern. That iz what this section covers. [t contains examples of common word processing
features and concepts. [talso explains the steps necessary to usea word processor to createa
new document: starting WordPerfect, entering and editing test, formatting and printing the
document, saving text on disk, and ending the session.

This course also explains how a word processor manages the computer’ s memory, discussing
where the characters generated by your keystrokes are moved and stored in every stage of word
rocessing.

Insert |HP Laserlet 5L [PCL) |Select| Pg 1 L 1.79" Pos 445"

CPI Training Solutions, |
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Open a File

Once afile has been saved, it is easy to retrieve back into memory by

clicking the Open tool. The Open File dialog box appears and displays a
list of filesin the current directory.

4 Open File - Student

File Edit “iew JToolz Fawornter Help

$lml@| X|e colnf= E k| B &lE)

Browse | QuickFinder |

Look in; I[:| Student j For type: IAIIFiIes[“."] j

[y Computer’, [C:)sMyFiles\Student [*%]

@basics.wpd

Mame: Iﬁ j

Open I DpengsEopyl Close |

|1 abject(z] |1.97KB [Disk free space: 128.34MB) | | v

Previewing a Document Before Opening

The Preview tool in the Open File dialog box allows the user to view a
document before opening it. A Viewer window is displayed in the lower
right corner of the screen.

In the next exercise, we will view the BASICS.WPD document.

1. Click the Open tool.
The Open File dialog box is displayed.
2. Click on BASICS.WPD inthefilelist.
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3.

4,

5.

Quick Open

Click the Preview tool.
A preview of the BASICS.WPD file is displayed in the pane on the
right side of the dialog box.

Preview tool
|

4 0pen File - Student

File Edit “iew Toolz Favoites Help

Browse | QuickFinderI
Look in: ID Student j Far type: IAII Files [ %) j

erh [CsMyFilesiStudent [ *.7]

MName: Ibasics.wpd
’WI Open as Cop_l,.ll Lloze |

|1 ohiectis] selected | 1.97KE [ [wordPerfect 7

Click [Open].
BASICS.WPD file is opened.
Close thefile.

Select Eile from the menu bar. At the bottom of the pull-down menu,
notice that up to four file names are listed. These are the names of the last
four filesyou have saved. Any one of the listed files can be opened
quickly by clicking the file name.
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4% Corel WordPerfect - Document1 (unmadified) HmEE
m Edit “iew Inzet Foimat Table Graphic: Toolz Window Help _|E|1|

Mew... Cirl+5 e+ 3 o e
LI e bl #|ul 2l El=l2] @] ]
T - Chl+Fs [l Stles - | Left +[1.0 -|Tables - [100% |

Save Ctrl+5 =

Save fs.. F3

Internet Publisher. ..

Document 3

Frrint... Chrl+P

Publizh ta 3

Send...

1 basics wpd

2 Comparny Announcements.wpd

3 Perzonnel Policy Updates.wpd

4 Mews Release for Mew Products. wpd

5 Employee Mailing List. wpd

E Memo for 4th Quarter Meeting.vpd

7 Propozal to Johnzon Brothers.wpd

& Mew Budget Report. wpd

9 Letfter to Bob Jones.wpd

Exit Al+F4 =
4 | *
Insert |HP Laser)et 5L [PCL) |Eelect| Pgd L 1" Pos 1"

1. Select File from the menu bar.
2. Click BASICSWPD.

Save a File With a
Different Name

This command allows afile to be saved under a new name, on a different
drive, or in adifferent file folder on the hard disk. A file can also be saved
asadifferent type of fileif it needs to be used with a different software
program.

1. Select Eile from the menu bar.
2. Choose Save As...
The Save As dialog box is displayed.
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4 Corel Office -- Save As - Student

Fle Edt Yiew Tools Favortes Help

| 3 [l

Browse I HuickFinder |

Save it |3 Studsrt B | Astype  [wordPerfect B.0/6.1 [™wpd " wpt™ 7]

|M_l,l Computer', [C:\MyFileshStudent [ “wpd |

bagics wod;

Name: Ibasics.wpd j

™ Paszword protect Save I Close |

|1 object(s) |2.02KE [Disk free space: 138.68MB) | | 4

3. Click inthe Name: box and type New Basics.
4. Click [Save].
File is saved as New Basics.wpd.

Start a New File

The New Blank Document tool opens a blank document. The File New
command allows the user to select from a group of templates. All default
margins, spacing and other formats are used in the Create a blank
document.

Select New Document

Group: Select template: WPYUS Select

: <Calendar Expert> -
<Fax Expert» Wiew...
<Letter Experts
<Memo Expert: Options
<M ewsletter Experts

Create a blank doc

LCloze

Help

ddidd].

Perzanal information: ﬂ, | <Ma perzonal information:

In the next exercise, we will start a new document.

e Click the New Blank Document tool.
A new blank document is displayed.
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Switch Between

Open Documents

There are now two documents open in WordPerfect: the new document
and the New Basics document.

The Window command on the menu bar allows a user to see what files are
currently open and switch to any of the open files.

In the next exercise, we will switch to the New Basics document.

1. Select Window from the menu bar.
2. Click on New Basics.wpd.
The New Basics document is displayed.

Preview a Document
Using Zoom

100%

Before printing a document, you may want to preview it to ensure that it is
placed on the page appropriately. The Zoom tool on the Power Bar
allows the user to determine how the document is to be displayed on the
screen.

v | 100% -
507
0%

150%
200%
kd argin WAfdt
Fage Width

Full Fage
Other...

In the next exercise, we will preview BASICS1.WPD.

=

Click the Zoom tool on the Power Bar.

2. Select Full Page.

Document is reduced to view the full page, as shown in the next
illustration.

CPI Training Solutions, Inc.



Page 22 Introduction to Corel WordPerfect 7.0

4 Corel WordPerfect - C:\MyFiles\Student\basics1 wpd [unmodified)
ﬁEiIe Edit Miew |nset Fomat Table Graphice Tools Window Help -|ﬁ'|i|

pleElE o z®lole] bllu] /Ly Bek @ e

QuickFonts  «|Times Mew Roman v |12 pt = | Shyles v | Left ~[1.0 ~|Tables

3. Click the Zoom tool and select 100% to return to 100% view.

E%jNOTE: Clicking the Page/Zoom Full tooI will display

the document in full page view also.

Print a Document

A quick way to print afilein Corel WordPerfect 7 isto use the Print tool
on the toolbar. In addition to the Print tool, the Eile Print command also
opens the Print dialog box. At times, it is necessary to print only a page
or two, or to request multiple copies of adocument or page. The dialog
box allows the user to choose what will be printed.
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Print to HP Laszerlet 5L [PCL]
Print | F'rinterl Two-Sided F'rintingl

— Current prinker

HP LaserJet 5L [PCL] [LPT1:)

— Print — Copies

Murnber of copies: I1 3:
IjEI Ijﬁ % [Callate

Fiesolution; IHigh B ] Group

= | Eritit ity ealar [ Print in reverze order

Fagerange. o I1 i’ _t'I'ZI i’

¥ PFrint graphics

™ | rielude decumert summan

Frint I LCloze | Settings = | Status | Help

To specify printing something other than the Full Document, click the list
arrow in the Print section. A list of optionsis displayed, as shown in the
following illustration.

— Print

Current Page j

Full D acurment

kultiple Pages
Advanced Multiple Fages
Diocument on Digk,

Feszalution: High j

™| Erirtirnzalar

To print just the current page, click the Current Page option and click the

[Print] button (or press <Enter>).

If only afew pages should be printed, click on the M ultiple Pages option.

Then specify in the Page r ange section the pages you wish to print.
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In the next exercise, we will print New Basics.

1. Click the Print tool.
2. Click the [Print] button.
The file is sent to the printer.

Exit WordPerfect

There are four different waysto exit any Windows program. These same
options are used for WordPerfect. Two of the methods use the
Application icon menu, asillustrated below:

Application Icon

Double-click the application icon, or

Click once on the application icon and choose the Close option, or
Click on File Exit, or

Press <Alt> <F4>.

' %jNOTE: If changes have been made to the document, be sure to
click [Yes] in the dialog box to save changes before exiting
WordPerfect.
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Part One

Part Two

Section 1
Summary Exercises

The following exercise will further develop skillsin the word processing
basics which were covered in Section |.

1. Typethe text below.
2. SavethefileasTraining.
3. Exit WordPerfect.

COMPUTER TRAINING CLASSES

Today many companies, as well as colleges and universities,
offer a variety of microcomputer courses. The Introduction to
Corel WordPerfect 7 for Windows course teaches you how to
use a powerful word processor in Windows. Other Windows
word processors include Microsoft Word and AmiPro for
Windows.

Electronic spreadsheet courses include Microsoft Excel, Lotus
1-2-3, and Quattro Pro for Windows. Other programs in which
you may be interested include database programs like Access
or Paradox. A popular desktop publishing program is Aldus
PageMaker.

Start WordPerfect.
Open the Training.wpd file.
Add the paragraph below to the bottom of the document.

wWN P

L ear ning to use microcomputers has become a " survival skill" for
the 1990's. Make the most of this opportunity to let your
education prepareyou for thejob market of today -- and
tomorrow.

Save the file as Computer Training.
Closethefile.

o &
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Part Three

0.

10.

The notifies the user that WordPerfect is open and
displays a document name.
The menu allows you to manually maximize,

minimize, move or size awindow.

The provides a quick method of changing fonts,
styles, paragraph formats and line spacing.

Y ou can change margins or table column-widths by dragging the
to the desired position.

The portion of the screen where text is located is called the text area or

The bottom of the screen isthe which keeps track of the
insertion point at al times.
The workspace can be set to different views. (True/ False)

Selecting a command in a pull-down menu which is followed by
ellipseswill resultin a

A file name can consist of only eight characters. (True/ False)

To affect specific portions of text, it isimportant to the text
first using the mouse or shift and arrow keys.
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Section 2
Formatting a Document

Apply Text Formats

Using the toolbar
In Corel WordPerfect 7 it is easy to apply character formats. Character
formats are attributes such as underline, bold, italics, highlighting or font
changes.

In the following exercises, we will apply some character formats.

Bold

2]

Open the file New Basics.wpd.

Savethefile as For matted Basics.

Select thetitle.

Click the Bold tool on the toolbar.

Click anywhere outside the selected area to turn the selection off.

b~ wbdPE

Italics

1. Double-click on the word Wor dPer fect in the middle of the first
paragraph.

Click the Italics tool on the toolbar.

3. Click anywhere outside the selected area to turn the selection off.

N

Underline

]

=

Select the word usersin the first sentence of the first paragraph.
Click the Underline tool on the toolbar.
3. Click anywhere outside the selected area to turn the selection off.

N

5 %jNOTE: Keyboard shortcuts can also be used to apply character
formats. For bold formats, press <Ctrl> <B>. For underline, use
<Ctrl><U> and for italics, <Ctr|> <|>.
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Mghlighting

A new feature of WordPerfect 7 is highlighting. Highlighting is used to
place atransparent color over text.

Y ou can change the highlight color and use severa colorsin the same
document.

Y ou can hide highlighting, then redisplay it. If your printer supports color
printing, the highlight colors will print. Black and white printers print the
colorsin gray. If you have hidden highlighting it does not print.

1.

2.

Select the text formatting and printing the document located near
the end of the first paragraph.

Click the Highlight tool on the toolbar.

The selected text is highlighted in yellow.

Change Highlight Color

Changing the highlight color is done through the Tools menu. In the next
exercise, we will change the highlight color and apply to text.

1
2.
3

No ok

. Select Tools from the menu bar.

Choose Highlight.

. Choose Change color ....

The Highlight Color dialog box is displayed.

Highlight Color EH

Color options oK I
Colaor: [::]|v

Shading: |1 S ﬂ

Cancel |

Help |

Click thelist arrow for Color:

Select the desired color.

Click [OK].

Select the words every stage of word processing located at the end of
the second paragraph.

Click the Highlight tool.

The new color is applied to selected text.
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Make Font Face and Point Size Changes

ITimes MHew Foman v|12 pt TI

Font Face

QuickFonts

I HuickFants - |I

Reveal Codes

Font Size

Font face and point size changes can easily be made using the Power Bar.
In the next exercise, we will change the font face and point size of the
title.

NoahkwdNpE

Point to thetitle and triple click to select it.
Click the Font Size button.

Click 14 in the pull-down list.

Click the Font Face button.

Click Arial in the pull-down list.

Click anywhere outside the selected area.
Save the file and |eave open.

QuickFonts can be used to change your font to afont setting which you
recently used. When you click the QuickFonts button on the Power Bar, a
list of your recent settingsis displayed. Settings such as point size and
font face will be shown, aswell as attributes such as bold and underline.

When character formats are added to text, hidden codes are embedded in
the document. These codes are used to turn on special effects when the
text is displayed on the monitor or sent to the printer.

1.

Press <Ctrl> <Home> to return the cursor to the top of the
Formatted Basicsfile.

2. Select View from the menu bar.
3.

Choose Reveal Codes.
A window opens at the bottom of the monitor as shown in the next
illustration.
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4.

Highlight
code

A Corel WordPerfect - C:\._ \MANUALS\WP70 Beginning\nztructor\basics2 wpd

ﬁfile Edit “iew Inset Format Table Graphic: Tool: ‘Wwindow Help _|5’|i|

nlz(als| flelalole] v 7|u] -8 H=a @c @l 2

QuickFonts | Aial v | 14pt | Styles - | Left *|1.0 =|Tables - | 100% - |

H WORD PROCESSING BASICS

Word processing users need to know what functions are commonly available and how to use
hem. That is what this section covers. [t contains examples of common word processing
features and concepts. Italso explains the steps necessary to usea word processor to createa
new document: starting WordFPerfect, entering and editing text, formatting and printing the
document, saving text on disk, and ending the session.

Inzert |HF Lazerlet 5L [PCL) [SeEctPal Ln 1" Pos 1

In the text window, click in front of the text every stage of word
processing.

Note the Highlight codes before and after the highlighted text in the
Reveal Codes window.

higgr courses: alsogexplaineg: how: 30> word<: processord: managess: thed computer s memory £ discussing
whered: thed characters<: generated<: bud pourd: keystrok ez ared movedS: and:: stored<> ing> [Highlight Jeverd: staged]

rocessin.

Notice the extra"codes' or commands which are included in the
Reveal Codes window. Theword [Bold] appears on a button in front
of the title and at the end of thetitle. Thisisreferred to asa"paired
code" because thereisan “on” code embedded when the format is
turned on and an "off" code embedded when the format is turned off.
Scroll through the document and watch the codes which appear in the
reveal codeswindow.
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Remove Text

Formats
There are two ways to remove text formats in Corel WordPerfect 7 for
Windows:
o Select the text and click on the tool of the attribute to be removed.
OR
o usetheleft mouse button to click and drag the format code straight
down off the monitor screen in Reveal Codes.

In the next exercise, we will remove the highlighting from the text in the
second paragraph.

1. Select the words every stage of word processing.

2. Click the Highlight tool.
The highlighting is removed from the text and the Highlight codes are
removed from the Reveal Codes window.

Turn off Reveal Codes

1. Select View from the menu bar.
2. Choose Reveal Codes.
Reveal Codes are turned off.
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Make Format and Font Changes
Using the Format Menu

Sample text

In addition to the character format buttons on the toolbar and the Power
Bar, there are many other attributes which may be applied to text. These
are displayed in the Format Font dialog box.

Font HE
Fort face: Fant size: .
ppearance

12
7 Symbol [E I Bold I Shadow Concel_|
T SymbolProp BT
T TAHOE 13 [ Undedine [ Small caps
T TallBop Caps :Ilg [~ Double underline [~ Redine ml
T TEDDY 15 [ Italic I™ Strikeout Iritial Fort... |
(T Times MNew Homan § 17 ™ out I Hidd -
T TOMORRDw =l 18 = (R Help |

19 » i —
Pt sl 310 Puosition: Felative size:

r re

% Nl ¢| Nomad ¢
Italic 23 — Underline options———————————————
Bald 24
Bald Italic 5 [V Spaces ™ Tabs

ar

— Colar optich
Text color: Shading:

B The Quick Brown Fox Jumps O -|v| Im

Resulting font:  Times Mew Roman Regular 12 pt [westemn)

Different typefaces are listed under the Font face section in the dialog
box. When the dialog box isfirst opened, the current font name will be
displayed along with Sample text in the lower left hand corner of the box.

Point and click on any of the Appear ance option boxes. Notice that the
Sample text has changed to match the selection.

In the next exercise, we will apply text formatting using the For mat Font
menul.

Lo

Select the text Word processing usersin the first sentence.

Select For mat from the menu bar.

3. Choose Font.
The Font dialog box appears.

4. Click the Shadow option box (or press <Alt> <w>).
A v appears in the check box.

5. Click [OK].

The selected text appears with a shadow.

Click outside the highlighted area.

Click the Undo tool.

Text is returned to original appearance.

N

No
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Apply Text

Formatting Using
QuickFormat

Use QuickFormat to copy fonts, attributes, and paragraph styles from one
area of text to another.

We will use QuickFormat to apply formatting to newly entered
subheadings in the For matted Basicsfile.

©CoNooA~WDNE

Click to position cursor in front of the first paragraph.
Type Common Functions.

Press <Enter>.

Click to position cursor in front of the second paragraph.
Type Managing Memory.

Press <Enter>.

Select the first subheading, Common Functions.

Apply bold, italicsand Arial font.

Click anywhere to deselect.

10 Select the word Common.
11. Click the QuickFormat tool.

The QuickFormat dialog box is displayed.

QuickFormat E

Copy the format at the insertion point ko
 Lharacters Cancel |

[copy fant, attributes]
[NEEartiiue.. |

" Headings

[copy paragraph format, styles, font, attribukes] Help |

12. Click [OK].

The I-beam has taken on the shape of a paintbrush.

13. Click and drag the paintbrush across the subheading M anaging

Memory.
The character formatting of bold, italic and Arial were copied from
the word Common and painted onto the words Managing Memory.

14. Click the QuickFormat tool to turn off the feature.
15. Savethefile.
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Change Paragraph

Formatting

In WordPerfect, first line indents and paragraph margin adjustments are
grouped under the For mat Paragraph Format command. If theformat is
set before text is typed, the format continues on to the next paragraph
when you press the <Enter> key. If you want to apply aformat after text
is entered, select the paragraph(s) first, then apply the desired format.

Paragraph Format EHE

0k

1=
a1+

Eirzt line indent:

Spacing between paragraphs; Cancel

Paragraph adjustments Clear &l

Left margin adjuzstment;

Plel

Help

=2 =2 -
k] |4l 4]e

Bight margin adjustment:

Indent Paragraphs

Indenting paragraphs can be accomplished using the Ruler or using the
Format Paragraph Format command.

We will create afirst line indent using the Format Paragraph For mat
command.

Select the first paragraph in the For matted Basicsfile.

Select For mat from the menu bar.

Choose Par agraph.

Choose Format...

The Paragraph Format dialog box appears.

Inthe Eirst Line Indent: box, key in .5.

Click [OK].

The selected paragraph will appear with the first line indented .5" .

7. Using the same technique, apply a.5” first line indent for the second
paragraph.

8. Savethefile and leave open.

El N

o u
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Change Line Spacing
10 -

Select the first paragraph in the document.

Click the line spacing button [1.0] on the Power Bar.

Select [2.0].

The first paragraph is double-spaced.

Using the same method, double-space the second paragraph.
Click anywhere in the text to deselect.

wNE

o s

Change Paragraph Alignment

| Left - !I

Paragraph alignment can be set from the For mat Justification menu
options. Paragraph alignment can also be set from the Power Bar
Justification button. Paragraphs can be aligned from the | eft, the right, or
fully justified on both the left and right margins. Justification means that
thefirst or last character on each line of type is accurately aligned with the
beginning or end of the lineimmediately above and below. There arefive
justification optionsin Corel WordPerfect 7 for Windows.

In the next exercise, we will center thetitle in the For matted Basicsfile.

1. Select thetitle.
2. Click the Justification button on the Power Bar.
3. Choose Center.
The title is centered between the left and right margins.

From the Format Justification menu options, the keyboard shortcuts are
visible for four types of paragraph alignment.

Left <Ctrl><L>
Right <Ctrl><R>
Full <Ctrl><J>
Center <Ctrl> <E>
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Change Document

Margins

Margin settings are available in the Format Margins menu. The

Mar gins dialog box allows the user to type exact measurements for all
margins. These changes are applied from the point of the cursor location
in the document. |f you want new margin settings to affect the entire
document, position the cursor at the top of the document before you
change the margins.

Margins E E

— Page margins
Left: % =
== L = Cahcel
Bight: |

Help
Top:

Bottom; |1

n

In the next exercise, we will change the left and right marginsto 2" .

1. Press<Ctrl> <Home> to move the cursor to the top of the document.
2. Select Format from the menu bar.
3. Choose Margins... (or press <Ctrl> <F8>).
The Margins dialog box appears.
4. Typethe number 2 in the L eft: text box and press <Tab>.
The cursor selects the 17 in the Right: margin text box.
Type the number 2 in the Right: text box.
Click [OK] (or press <Enter>) to accept the changes.
Click the Zoom/Full Page tool to view the document with the new
margins.
Return to 100% view.
Savethefile.

No o

© ©
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Set Document for

Landscape Printing
Landscape printing is available in WordPerfect. To select landscape
orientation, use the For mat, Page, Page Size command.

Name list arrow

In the next exercise, we will select landscape orientation.

1
2.
3

. Select Format from the menu bar.
Select Page.

. Choose Page Size...
The Page Size dialog box is displayed.

9.
10.

Page Size
— Page definition
Mame:
Fopes Sbadard
Size: 85" e 11"
Adjustment: Up 0"
Left 0

Orientation

Portrait

Paper source:
Default

Ok

Cahcel

WA,

Click thelist arrow for Name:
Choose L etter L andscape.
Click [OK].

Click the Zoom/Full Page tool.
The page will display in landscape.
Return to 100% view.
Using the same technique, return to L etter page size.
Save and close thefile.

Edit...

Celete...

[ |
=N

Mew... |
_ea. |
_Dekte. |
_ e |

Help
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Part One

Part Two

Section 2
Summary Exercises

Open the file Softwar e.wpd.

Save thefile as Softwar e Revised.

Apply bold and Arial 14 point to thetitle.

Center thetitle.

Double space the document.

Indent the first line of each paragraph one-half inch.
Change the left and right margins to one and a half inches.
Savethefile.

Closethefile.

CoNoO~WDNE

SOFTWARE

Softwareistheterm used for computer programs. For personal
computer applications, softwareisusually purchased from
development companiesfor office or personal use. Theuser hasno
involvement in the actual writing of the programsnor can the
program be altered to suit specialized needs.

Application Software

The most popular software programsfor the personal computer are
word processing, financial or spreadsheet, and database functions
which allow the user flexibility in utilization. Thisgroup of software
iscalled " application" software becauseit iswritten for one
particular function or application.

Word processor s like Wor dPerfect turn the personal computer into a
sophisticated typewriter, allowing the user to save documents and
makerevisionsat alater time.

Open the file Softwar e Revised.wpd.

Set the document to print in landscape orientation.

In the last paragraph, place the word Wor dPerfect in bold.
Change the left and right margins to two inches.

Save and close thefile.

abrowdE
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Part Three

font setting.

. To select landscape orientation, use the

is used to place atransparent color over text.

. Pressing <Ctrl><I> will apply the attribute to your selected

text.

can be used to change your font to arecently used

. Theterm “paired code” is used when an “on” code is embedded when

aformat is turned on and an “ off” code is embedded when aformat is
turned off. (True/ False)

. When the paragraph format is set before the text is typed, the format

continues only through the first paragraph. (True/ False)

Indenting paragraphs can be accomplished using the Ruler or using the
command.

. Theterm means that the first or last character on each

line of type is accurately aligned with the beginning or end of the line
immediately above and below.

. The dialog box allows the user to type exact measurements

for al margins.

command.
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Notes:
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Section 3 Editing and
Correcting a Document

Edit and Tools Menus

In Corel WordPerfect 7 for Windows, the Edit menu is used for specia
editing features like cut and paste. The T ools menu contains aids such as
spell checking, thesaurus and a grammar checker. Both menus are
important for putting the "final touch” on documents.

Using Spell Check

The Spell Check feature in WordPerfect allows a user to electronically
check for misspelled words. WordPerfect has a dictionary that contains
115,000 of the most commonly misspelled words. 1t compares the words
in the document with the words in the dictionary.

The spelling checker begins at the cursor position in the document and
checksin the forward direction. If the document contains aword that is
not in the dictionary, WordPerfect will stop and give you several options
from which to choose.

A Corel WordPerfect - C:\._ \MANUALS\WP70 Beginning\Student\BADSPELL WPD [unmodified) HEE

@Eile Edit “iew Inset Format Table Graphic: Tool: Window Help ;Iilil
DS slml@ o] bllul -|& El=lE @lE] eld]

QuickFonts ¥ | Times New Roman v |14pt v | Shfes - | Left *[1.0 | Tables - [ 100% |

Work processing was one of the earliest applications kg for micrcomputers. |
It involves typing and editng any kind of text like letters, articles or books. The
words you type are displayed ona computr screen. You can changes those words,
move therm around or erase themn without having to retype the entire document. &

a |

Spell Chacker | Grammatikl Thesaurusl

Mot found: I developd Replace I BuickCorect |
Replace with: ||developed Skip Once | Unda |
Replacements: Skip Alwayps | Suggest |
g:x::ggs Add | Customize |
Add to: IWtB‘I us.Lwl j
Check: I Document j
LCloze | Help |
Insert |HP Laserlet 5L [PCL) |Select Pg1 Ln1" Pos 518"
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In the next exercise, we will open adocument that contains spelling errors
and use the Spelling tool to assist in correcting those errors.

1
2.

o u

B © oo N

11.
12.

13.

L

pell-As-You-Go

Open the file Badspell.wpd.

Click the Spelling tool.

The word developd will appear in the Not found: section..

Click on the word developed in the Replacements:. box.

The word developed appears in the Replace with: box..

Click the [Replace] button.

The word developd is replaced with the correctly spelled developed.
Repeat for other misspelled words.

When an unrecognized word such as ona appears, click on thetext in
the document to manually correct.

Click after the n in the Replace with box.

Press the [Space bar].

Typea.

. Click [Replace].

The speller dialog box is suspended, the active title bar becomes

inactive, and a [Resume] button appears.

Continue the spell check.

Click the [Yes] button when WordPerfect asks if you want to close the spell
checker.

Save and close thefile.

Spell-as-you-go isanew featurein WordPerfect 7. Asyou type,
WordPerfect checks your spelling. If aword isfound in your document
that is not in the dictionary, WordPerfect will place ared line beneath the
word. When you right-click the word, spelling options appear in a
shortcut menu.

1.
2.

3.

Start a new document.

Type documnet and press the [ Space bar].

A red line appears beneath the word.
Right-click the word.

A shortcut menu appears with suggested words.
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H documnet
docurment
documents

&dd

Skip in Document

Spell Check...

What's This?

4. Click document.
The misspelled word is replaced with the correctly spelled one.
5. Closethe file without saving.

Using Thesaurus

A thesaurus provides synonyms for words. Thereisan electronic
thesaurus inside WordPerfect which allows a user to ook at replacements
for overused words in a document.

Open the file Formatted Basics.

Save thefile as Revised Basics.

Position the cursor in the word BASICSin thettitle.
Select T ools from the menu bar.

Choose Thesaurus...

The Thesaurus dialog box appears.

g wbhPE
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4. Corel WordPerfect - C:\.._\MANUALS\WP70 Beginning\Instructor\basics3.wpd HEE
@Eile Edit Yiew Insert Format Table Graphice Tool: Window Help -|ﬁ'|5|
Dlz(@&8 &le=l@olc] bllu] L& E=lE @l el
QuickFonts | Avial > |14 pt =[Skl - | Left +[1.0 =|Tables ~| 1005 ~|
B
WORD PROCESSING YIS | :
4 L]
Spell Checkerl Grammatik,  Thesaurus |
Replace With: Replace | Undolos |
IHASlCS j Look Up I History Vl CustomiZEV|
j BASICS j
unym o
essentials
principles
rudiments
rules =
Cloze Help
Inzert |HP Laserlet 5L [PCL] |Select| Pg 1 Ln 1" Pos 3.02"

The word basic (a) appears at the top of the first column. Synonyms
are listed in the text box below. Some words have bullets in front of
them. This indicates that there are also synonyms for these words
included in the Thesaurus.

6. Double-click theword principles.

Synonyms for the word principles appear in the second column box.
7. Click once on the word Fundamental in the first column box.
8. Click the [Replace] button.

The word BASICS in the title is replaced with the word
FUNDAMENTALS.

Find and Replace
Text

A very useful tool in any word processor is the Find command which can
quickly locate text anywhere in the document. The indicated text will be
highlighted once it is found by the Find feature.

In WordPerfect, the Eind and Replace command is located in the Edit
menu.
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Twpe Match Heplace Action Options Help
Finc: el =

% Find and Replace Text

Replace with:

j Bt Erey

Eeplase

I <Mothing: j Eenace Sl

Cloze

L

In the next exercise, we will use the Find command to locate the word
word.

8.
9. Click [Closg].

Press <Ctrl> <Home> to return to the top of the document.
Select Edit from the menu bar.

Choose Eind and Replace... (or press <F2>).

Typeword in the Find: box.

Click [Eind Next] or pressthe <Enter> key.

WORD is selected in the title.

Click [E